
GRADUATE COUNCIL: NEW COURSE PROPOSAL

Originating Unit: NEELEY (ACCT)

Type of action: ri New course El Full online course**

Semester and year course will take effect: Summer 2023

New course title: Accounting and Analytics

Appropriate computer abbreviation (30 spaces or less): Accounting and Analytics

Course instructional methodology: Lecture

course component types: ugradcouncil.tcu.edu/forms/Course Component Types.pdf

New course number: ACCT 60110

Prerequisites for new course: include an attachment if additional space is needed
Admitted to Master of Science in Business Analytics program

Click here to attach a file attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments



Description of new course (catalog copy): include an attachment if additional space is needed

This course is designed to give you the foundations to read, understand, and analyze financial
statements. You will also learn variety of analytical skills to identify and assess business risks within key
transaction processing cycles fundamental to companies across industries. Effectively communicating
with accounting professionals will enhance your business decisions. Our goal is to have you understand
the language of accounting and the logic of the accounting system in order to effectively use financial
information.

Click Gaoco .erroba file attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments



Fully Online Courses**
All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.
Contact the Koehler Center for Teaching Excellence for guidelines. Include a letter of support from the Koehler Center
with this proposal.

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed
See attached syllabus.

Click here to attach a file

Additional resources required:

Faculty: none

Space: none

Equipment: none

Library: none

Financial Aid: none

Other: none

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments

Change in teaching load: no

Does this change affect any other units of the University? 111 Yes n No

If yes, submit supporting statement signed by chair of affected unit.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units.



Chair of Originating Unit:

Name: Bill Wempe

Unit : Neeley, Department of Accounting

Signature: Bill Wempe Digitally signed by Bill Wernpe
/—Date: 2022.11.07 17:57:16 -.06'00'



633 Nee ley
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ACCT 60110 Accounting Fundamentals with Analytics

Instructor Name: Mark Wills
Semester/Year: Summer 2023
Number of Credits: 1.5
Class Location: Online with a hybrid format
Class Meeting Day(s) & Time(s): Synchronous sessions (Zoom) from 9:00 to 10:15 AM
Office Hours: Virtual office hours (Zoom) from 1 to 2pm, M-F, and by appointment
Telephone: 817-257-4837
Email: mark.wills@tcu.edu (preferred contact method)
Response Time: I will respond to emails and phone calls within 24 hours.

Exam Dates & Other Important Dates

June 9, 2021 Mid-term Exam TCU Online

June 16, 2021 Final Exam* TCU Online

Prerequisites:

Graduate Level Standing

Course Objectives: This course is designed to give you the foundations to read, understand,
and analyze financial statements. You will also learn variety of analytical skills to identify and
assess business risks within key transaction processing cycles fundamental to companies across
industries. Effectively communicating with accounting professionals will enhance your business
decisions. Our goal is to have you understand the language of accounting and the logic of the
accounting system in order to effectively use financial information.

There are three significant leadership agility skills that you should utilize during the semester:
mental agility, results agility, change and people agility. Accounting supports data driven
decision-making and ensures accountability. To use financial information for operating and
strategic decisions, you need to understand what type of problems can be addressed with
accounting information, identify relevant information in a mass of data, recognize how
accounting choices can bias reported results and use accounting data to evaluate business
decisions.
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To be successful you must be able to communicate your information needs to those who
prepare accounting information for you. If you understand accounting but cannot
communicate it to others, your knowledge is of limited value. If your accounting background is
weak and you are unable to form questions to elicit the information you need, it will be more
difficult to make good financial and business decisions. This course is designed to strengthen
your ability to recognize issues and elicit the appropriate information to make sound financial
decisions.

The perspective that we will take in this course will be that of the general management of an
organization, not a preparer of financial reports (i.e. an accountant). However, it is necessary to
understand how to construct financial statements in order to answer the questions that we seek.

Required Textbook

Financial Accounting for MBAs, 8th edition with MyBusinessCourse (Cambridge Business), by
Easton, Wild, Halsey, and McNally. The textbook is available at TCU Bookstore. It includes an
access code for MyBusinessCourse, an e-learning website developed by the publisher that gives
you access to homework, pre-class quizzes, author-prepared e-lecture videos and eBook. You
can also purchase the textbook or the access code for MyBusinessCourse from the publisher's
website: https ://mybu sines scourse.com/book/financi al accountingformbas 8e#purchase 

Required Resources provided by Instructor
• Alteryx
• SAP Hana

• Note 1: We will use MS Teams to post lecture notes, videos, exercises, and submit assignments.
TCU online will be used to post grades.

• Note 2: A PC with Microsoft Windows 7+ is required.

Teaching Philosophy

An increasingly global business environment and rapidly changing technologies are fueling a
demand for accounting professionals with advanced skills and up-to-date knowledge. University
education helps students build a foundation for career success. My objective is to help students
acquire the knowledge and skills that will help them succeed in their professional careers. I am
passionate about teaching and believe that I can be a positive influence on students and, at a
broader level, on society.
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Instructional Methods

This class adopts a hybrid course format. It has both synchronous class meetings and
asynchronous learnings activities on TCU Online and MyBusinessCourse.

Asynchronous learnings activities are primarily done on MyBusinessCourse. You will read the
assigned chapter(s), watch e-lectures, take pre-class quizzes, and do your homework on
MyBusinessCourse. My virtual office hours offer you great opportunities to do Q&As with me
on an individual basis. The key advantage of asynchronous learnings is flexibility — you control
your own pace and can interact with me and your peers regardless of location and time barriers.
The key challenge of asynchronous learnings is self-discipline — you must be focused and
committed. Asynchronous learnings require strong time management skills.

Synchronous class meetings on Zoom are scheduled for 9:00 — 10:15 Monday-Thursday. During
those meetings, we will go over important topics covered in each chapter and have real-time
discussions and live collaboration. Slides and instructor lecture notes will be posted on TCU
Online before the meetings. We will also work on practice exercises to internalize what we have
learned. Occasionally, I will send you interesting articles related to covered topics to read and
you should be prepared to discuss them and share your thoughts during synchronous class
meetings. Post-class quizzes are completed during times outside of class meetings.

Final Grade Elements / Grade Breakdown:

Assignments, Exams/Quizzes, Presentations, etc. Points

Mid-term exam 100

Final exam 100

Quizzes on TCU Online 60

Homework on MyBusinessCourse 60

Synchronous class meeting attendance 20

Total: 340

Final grade calculation will be based on the point values above.

Exam Policies:

Exams are designed to test your understanding of the material covered in class, your
assignments, and your assigned textbook chapters. Exams are not designed to test your
memorization skills. Exams may consist of multiple choice, short-answer, and work-out
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questions in order to assess your ability to apply and explain concepts. Partial credit may be
given for work-out questions if you show your calculations. You will take both exams on TCU
Online with Respondus Lockdown Brower. Please make sure you have the right to install
Respondus Lockdown Brower on the computer that you will be using for the two exams.
Both exams will be open book, open notes, and you may use any calculators for computational
questions. No other materials or personal help are permitted during the exams.

If for any reason you must miss an exam, I expect you to contact me in advance and take the
exam prior to the regularly scheduled exam. For any consideration, I must approve all absences
in advance. I expect you to make an extraordinary effort to contact me as soon as you become
aware that there may be an issue. I reserve the right to refuse make-up examinations after a
regularly scheduled exam has been administered, and I also reserve the right to change the
content/format of any make-up exams. Any unexcused absences may result in a zero for a
missed exam.

Quizzes:

Six 10-point QUIZZES will be administered. No make-up quizzes will be administered,
regardless of the reason a quiz was missed. However, quizzes missed for a legitimate reason
(e.g., serious illness or other emergency) will not count against you. Thus, if you miss one of the
six quizzes due to an excused absence, then your scores on five quizzes will determine what
portion of the 60 points you will receive. The fact that all quizzes are worth 10 points should not
be construed to mean that the format, content, and difficulty are the same for each quiz.
No make-up Quizzes will be administered, regardless of the reason a quiz is missed.

In-class Assignments:

You will spend a portion of each class period completing practice problems in a group setting. I
do not expect that you will complete all assigned problems during the allotted time. The
assignments will be not be graded, nor will you be required to submit your work. Evidence of
completion will be based on attendance in class. I strongly encourage you to work through these
assignments as preparation for the quizzes and exams.

Homework:

Your homework questions are assigned on a per-chapter basis through MyBusinessCourse. To
receive credit for a homework assignment, you must submit your answers by the due date. No
late homework will be accepted, regardless of the reason an assignment is missed.

MyBusinessCourse is the best way to provide you with immediate feedback about your
understanding of the content. However, since MyBusinessCourse is an electronic tool, you might
tend to assume you know a topic better than you really do. I strongly encourage you to work
through the homework problems using pencil/paper to ensure that you actually understand
the material. However, all final homework submissions must be made through the
MyBusinessCourse website.
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Attendance:

I expect you to attend the synchronous class meetings and, more importantly, to be mentally
present. You are required to join the synchronous session with video and audio.

Absences: If you must miss a synchronous session for any reason, I expect you to inform me
before the missed session to obtain information about the material that will be covered. Please
note, I will not re-teach information presented in the synchronous session during virtual office
hours, so it is in your best interest to attend the synchronous session. It is your responsibility to
find out about class announcements, material, and deadlines by checking with a peer, TCU
Online, and MyBusinessCourse.

I expect you to be on time to the synchronous session and stay for the whole session. I
understand that emergency situations may arise that require you to arrive late or leave early, but
not often. If such a situation should arise, I expect the courtesy of an explanation by email.

Note that synchronous session activities are not designed to benefit poorly prepared students.
Therefore, I strongly encourage you to read the assigned chapter, watch e-lectures prepared by
the publisher, and complete a pre-class quiz before the synchronous session. To be successful in
this class, you should plan to spend an average of 2 hours previewing the course materials before
the synchronous session every day. Strive to understand, not memorize. If you do not understand
the reason for something you see in the textbook or video demonstrations on MyBusinessCourse,
please ask me about it during the synchronous session. Active engagement and discussion are the
best use of your synchronous session time.

Class Norms & Netiquette

All members of the class are expected to follow rules of common courtesy in all email messages,
discussions, and chats. If I deem any of them to be inappropriate or offensive, I will forward the
message to the Chair of the department and appropriate action will be taken, not excluding
expulsion from the course. The same rules apply online as they do in person. Be respectful of
other students. Foul discourse will not be tolerated. Please take a moment and read the basic 
information about netiquette (http://www.albion.com/netiquette/).

Participating in the virtual realm, including social media sites and shared-access sites sometimes
used for educational collaborations, should be done with honor and integrity. Please review 
TCU's guidelines on electronic communications (email, text messages, social networks, etc.)
from the Student Handbook. (https://tcu.codes/policies/network-and-computing-policy/e-mail-
electronic-communications-social-networks/)
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Technology Policies

• Email

Only the official TCU student email address will be used for all course notification. It is your
responsibility to check your TCU email on a regular basis.

• Course Materials

TCU students are prohibited from sharing any portion of course materials (including videos,
PowerPoint slides, assignments, or notes) with others, including on social media, without written
permission by the course instructor. Accessing, copying, transporting (to another person or
location), modifying, or destroying programs, records, or data belonging to TCU or another user
without authorization, whether such data is in transit or storage, is prohibited. The full policy can
be found at: https://security.tcu.edu/polproc/usage-policy/.

Violating this policy is considered a violation of Section 3.2.15 of the Student Code of
Conduct (this policy may be found in the Student Handbook at https://tcu.codes/code/index/),
and may also constitute Academic Misconduct or Disruptive Classroom Behavior
(these policies may be found in the undergraduate catalog at
https://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-
Conduct-Policy-Details). TCU encourages student debate and discourse; accordingly, TCU
generally interprets and applies its policies, including the policies referenced above, consistent
with the values of free expression and First Amendment principles.

• MyBusinessCourse

If you have technical issues with MyBusinessCourse, you will need to contact
MyBusinessCourse customer support at (630) 504-0505. You may also submit a ticket on their
student support webpage https://mybusinesscourse.com/contact

Academic Misconduct

Academic Misconduct (Sec. 3.4 from the TCU Code of Student Conduct): Any act that violates
the academic integrity of the institution is considered academic misconduct. The procedures used
to resolve suspected acts of academic misconduct are available in the offices of Academic Deans
and the Office of Campus Life and are listed in detail in the Undergraduate Catalog and the
Graduate Catalog Specific examples include, but are not limited to:

• Cheating: Copying from another student's test paper, laboratory report, other report, or
computer files and listings; using, during any academic exercise, material and/or devices
not authorized by the person in charge of the test; collaborating with or seeking aid from
another student during a test or laboratory without permission; knowingly using, buying,
selling, stealing, transporting, or soliciting in its entirety or in part, the contents of a test
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or other assignment unauthorized for release; substituting for another student or
permitting another student to substitute for oneself.

• Plagiarism: The appropriation, theft, purchase or obtaining by any means another's
work, and the unacknowledged submission or incorporation of that work as one's own
offered for credit. Appropriation includes the quoting or paraphrasing of another's work
without giving credit therefore.

• Collusion: The unauthorized collaboration with another in preparing work offered for
credit.

• Abuse of resource materials: Mutilating, destroying, concealing, or stealing such
material.

• Computer misuse: Unauthorized or illegal use of computer software or hardware
through the TCU Computer Center or through any programs, terminals, or freestanding
computers owned, leased or operated by TCU or any of its academic units for the purpose
of affecting the academic standing of a student.

• Fabrication and falsification: Unauthorized alteration or invention of any information
or citation in an academic exercise. Falsification involves altering information for use in
any academic exercise. Fabrication involves inventing or counterfeiting information for
use in any academic exercise.

• Multiple submission: The submission by the same individual of substantial portions of
the same academic work (including oral reports) for credit more than once in the same or
another class without authorization.

• Complicity in academic misconduct: Helping another to commit an act of academic
misconduct.

• Bearing false witness: Knowingly and falsely accusing another student of academic
misconduct.
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TCU Online: Our Learning Management System

Getting Started with TCU Online

Technical Requirements: Check your computer is ready by looking at the specifications list.
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements)

Log In: (using your TCU Network Credentials)

1. Access via my.tcu.edu > Student Quick Links > TCU Online
2. Login at the following website (http://d21.tcu.edu) my.tcu.edu

*For information about logging into TCU Online, view these instructions.
(http://tcuonline.tcu.edu/kb/how-do-i-log-in/).

Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online
Student Orientation Tutorial, please do so now. To access it, click on the Orientations semester
OR view all courses in your My Courses widget visible upon logging in to TCU Online. Click on
the "Student Orientation Tutorial" to enter the orientation course. Follow the instructions in the
course. You can return to this tutorial at any time.

I will post announcements, handouts, homework assignments, class readings, grades, and other
materials on TCU Online. You will also take your post-class quizzes and exams on TCU Online
with Respondus Lockdown Brower.

Getting Help with TCU Online

If you experience any technical problems while using TCU Online, please do not hesitate to
contact the TCU Online (D2L) Help Desk. They can be reached by phone or chat 24 hours a day,
7 days a week, 365 days a year.

Phone: 1-877-325-7778
Chat: Chat is available within TCU Online in the Help menu on the navigation bar.

If you are working with the Help Desk to resolve a technical issue, make sure to keep me
updated on the troubleshooting progress.

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please
contact me.

Personal Settings & Notifications for TCU Online

As a student, you should set up your account settings, profile, and notifications. To do this you
will login to TCU Online and select your name on the top right of the screen. In the Profile area,
you can upload a photo of yourself and add personal information. In the Notifications area, you
can add your phone number to receive text messages when grades are given as well as reminder
texts for upcoming assignments and quizzes.
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Student Success Tools for TCU Online

Pulse

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and
announcements. This app provides a graph that can help you manage your time. Based on the
number of assignments and events on the course calendar for your classes, the graph will display
busy times for class work in the upcoming week. You can use this app to manage your daily
workload, and it includes the ability to view and access course materials offline. You can
download Pulse from the Google Play or Apple Store. You can learn more and download Pulse
here:  https://www.d21.com/products/pulse/.

ReadSpeaker

ReadSpeaker includes a number of tools that can enhance your understanding and
comprehension of course materials. ReadSpeaker can create an audio version of content that you
can listen to while on a page within a course or that you can download to listen offline.
ReadSpeaker can also read Microsoft Office files and PDFs. There are additional tools and
features to assist you with reading and focusing in TCU Online, tools that provide support for
writing and proofing text, and tools that can read non-TCU Online content aloud. You can learn
more about how to use ReadSpeaker tools here: https://tcuonline.tcu.edu/how-to-hub/instructor-
how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/
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Support for TCU Students

Campus Offices

• Alcohol & Drug Education Center (817-257-7100, Samuelson Hall basement)
• Brown-Lupton Health Center (817-257-7938 or 817-257-7940)
• Campus Life (817-257-7926, Sadler Hall 2006)
• Center for Academic Services (817-257-7486, Sadler Hall 1022)
• Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003)
• Counseling & Mental Health Center (817-257-7863, Samuelson Hall basement)
• Mary Couts Burnett Library (817-257-7117)
• Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1st floor)
• Student Development Services (817-257-7855, BLUU 2003)
• Center for Writing (817-257-7221, Reed Hall 419)
• Transfer Student Center (817-257-7855, BLUU 2003)
• Veterans Services (817-257-5557, Jarvis Hall 219)

Anti-Discrimination and Title IX Information

Statement on TCU's Discrimination Policy

TCU prohibits discrimination and harassment based on age, race, color, religion, sex, sexual
orientation, gender, gender identity, gender expression, national origin, ethnic origin, disability,
predisposing genetic information, covered veteran status, and any other basis protected by law,
except as permitted by law. TCU also prohibits unlawful sexual and gender-based harassment
and violence, sexual assault, incest, statutory rape, sexual exploitation, intimate partner violence,
bullying, stalking, and retaliation. We understand that discrimination, harassment, and sexual
violence can undermine students' academic success and we encourage students who have
experienced any of these issues to talk to someone about their experience, so they can get the
support they need.

• Review TCU's Policy on Prohibited Discrimination, Harassment and Related Conduct or
to file a complaint: https://titleix.tcu.edu/title-ix/.

• Learn about the Campus Community Response Team and Report a Bias Incident: 
https://titleix.tcu.edu/campus-community-response-team/

Statement on Title IX at TCU

As an instructor, one of my responsibilities is to help create a safe learning environment on our
campus. It is my goal that you feel able to share information related to your life experiences in
classroom discussions, in your written work, and in our one-on-one meetings. I will seek to keep
any information your share private to the greatest extent possible. However, I have a mandatory
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reporting responsibility under TCU policy and federal law and I am required to share any
information I receive regarding sexual harassment, discrimination, and related conduct with
TCU's Title ix Coordinator. Students can receive confidential support and academic advocacy
by contacting TCU's Confidential Advocate in the Campus Advocacy, Resources & Education 
office at https://care.tcu.edu/ or by calling (817) 257-5225 or the Counseling & Mental Health 
Center at https://counseling.tcu.edu/ or by calling (817) 257-7863. Alleged violations can be 
reported to the Title IX Office at https://titleix.tcu.edu/student-toolkit/ or by calling (817) 257-
8228. Should you wish to make a confidential report, the Title IX Office will seek to maintain
your privacy to the greatest extent possible, but cannot guarantee confidentiality. Reports to law
enforcement can be made to the Fort Worth Police Department at 911 for an emergency and
(817) 335-4222 for non-emergency or TCU Police at (817) 257-7777.

Obligations to Report Conduct Raising Title IX or VAWA Issues

Mandatory Reporters: All TCU employees, except Confidential Resources, are considered
Mandatory Reporters for purposes of their obligations to report, to the Coordinator, conduct that
raises Title IX and/or VAWA (Violence Against Women Act) issues.

Mandatory Reporters are required to immediately report to the Coordinator information about
conduct that raises Title IX and/or VAWA issues, including any reports, complaints or
allegations of sexual harassment, discrimination and those forms of prohibited conduct that relate
to nonconsensual sexual intercourse or contact, sexual exploitation, intimate partner violence,
stalking and retaliation involving any member of the TCU community, except as otherwise
provided within the Policy on Prohibited Discrimination, Harassment and Related Conduct.

Mandatory Reporters may receive this information in a number of ways. For example, a
complainant may report the information directly to a Mandatory Reporter, a witness or third-
party may provide information to a Mandatory Reporter, or a Mandatory Reporter may
personally witness such conduct. A Mandatory Reporter's obligation to report such information
to the Coordinator does not depend on how he/she received the information. Mandatory
Reporters must provide all known information about conduct that raises Title IX or VAWA
issues to the Coordinator, including the identities of the parties, the date, time and location, and
any other details. Failure of a Mandatory Reporters to provide such information to the
Coordinator in a timely manner may subject the employee to appropriate discipline, including
removal from a position or termination of employment.
Mandatory Reporters cannot promise to refrain from forwarding the information to the
Coordinator if it raises Title IX or VAWA issues or withhold information about such conduct
from the Coordinator. Mandatory Reporters may provide support and assistance to a
complainant, witness, or respondent, but they should not conduct any investigation or notify the
respondent unless requested to do so by the Coordinator.

Mandatory Reporters are not required to report information disclosed (1) at public awareness
events (e.g., "Take Back the Night," candlelight vigils, protests, "survivor speak-outs," or other
public forums in which students may disclose such information (collectively, public awareness
events); or (2) during an individual's participation as a subject in an Institutional Review Board
approved human subjects research protocol (IRB Research). TCU may provide information
about Title IX rights and available resources and support at public awareness events, however,
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and Institutional Review Boards may, in appropriate cases, require researchers to provide such
information to all subjects of IRB Research.

911 for an emergency and (817) 335-4222 for non-emergency or TCU Police at (817) 257-7777.

Statement of Disability Services at TCU

Disabilities Statement: Texas Christian University complies with the Americans with Disabilities
Act and Section 504 of the Rehabilitation Act of 1973 regarding students with disabilities.
Eligible students seeking accommodations should contact the Coordinator of Student Disabilities 
Services in the Center for Academic Services located in Sadler Hall, room 1010 or
http://www.acs.tcu.edu/disability services.asp.

Adequate time must be allowed to arrange accommodations and accommodations are not
retroactive; therefore, students should contact the Coordinator as soon as possible in the
academic term for which they are seeking accommodations.

Further information can be obtained from the Center for Academic Services, TCU Box 297710,
Fort Worth, TX 76129, or at (817) 257-6567.

Each eligible student is responsible for presenting relevant, verifiable, professional
documentation and/or assessment reports to the Coordinator. Guidelines for documentation may
be found at http://www.acs.tcu.edu/disability documentation.asp.

Students with emergency medical information or needing special arrangements in case a building
must be evacuated should discuss this information with their instructor/professor as soon as
possible.

Emergency Response Information

Please review TCU's L.E.S.S. is More public safety video to learn about Lockdown, Evacuate,
and Seek Shelter procedures. (https://publicsafety.tcu.edu/less-is-more/)

TCU's Public Safety website provides maps that show our building's rally point for evacuation
and the seek shelter location. (https://publicsafety.tcu.edu/)

In the event of an emergency, call the TCU Police Department at 817-257-7777.

Download the Frogshield Campus Safety App on your phone. (https://police.tcu.edu/frogshield/)
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Student Perception of Teaching (SPOT)

Towards the end of the term you will receive an email asking to complete your SPOT for this course. I appreciate your thoughtful and
reflective feedback to help make this course successful for future students. You can fill out the SPOT by clicking on the link in the
email or in TCU Online when SPOTs open.

TCU Mission Statement

To educate individuals to think and act as ethical leaders and responsible citizens in the global community.

The Neeley Promise

The Neeley School of Business unleashes human potential with leadership at the core and innovation in our spirit.
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Course Schedule

This calendar represents my current plans and objectives. As we go through the semester, those plans may need to change to enhance
the class learning opportunities. Such changes will be clearly communicated.

Date Topic Assigned Content Learning Activity

Day 1 Financial Accounting,
Introducing Financial
Statements

Chapters 1 and 2 of the
textbook;

E-lecture videos

Synchronous class meeting on Zoom 9:00 — 11:00

TCU Online Quiz- Available from Monday 6:00
PM - Tuesday 2:00 PM

Day 2 Transactions, Adjustments,
and Financial Statements

Introduction to Alteryx

Chapter 3 of the textbook;

E-lecture videos

Alteryx Tutorial Video

Chapter 1 & 2 Homework due 2:00 PM

Synchronous class meeting on Zoom 9:00 — 11:00

TCU Online Quiz- Available from Tuesday 6:00
PM — Wednesday 2:00 PM

Day 3 Revenue & Receivables

AR Aging Analysis Using
Alteryx

Chapter 5 of the textbook;

E-lecture videos

Chapter 3 Homework due 2:00PM

Synchronous class meeting on Zoom 9:00 — 11:00

TCU Online Quiz- Available from Wednesday
6:00 PM - Thursday 2:00 PM

Day 4 Inventories, Accounts
Payable, Long — Term Assets

Expenditure (3-way match)
Assignment using Alteryx)

Chapter 6 of the textbook;

E-lecture videos

Chapter 5 Homework due 2:00PM

Synchronous class meeting on Zoom 9:00 — 11:00

TCU Online Quiz- Available from Thursday 6:00
PM - Friday 2:00 PM

Day 5 SAP S4 Financials Global Bike Case Study

E-lecture Videos

Synchronous Class Meeting on Zoom 9:00-11:00

Journal Entry Case Submission due by midnight
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Date Topic Assigned Content Learning Activity

Mid-Term Exam Friday 6:00 PM- Sunday
11:59 PM Chapters 1, 2, 3, 5

Day 6 SAP S4 Controlling Global Bike Case Study

E-lecture Videos
Synchronous Class Meeting on Zoom 9:00-11:00
Cost Center Case Submission due by midnight

Day 7 Current and Long — Term
Liabilities

Chapters 7 of the textbook;

E-lecture videos
Chapter 6 Homework due 2:00PM
Synchronous class meeting on Zoom 9:00 — 11:00
TCU Online Quiz- Available from Monday 6:00

PM - Tuesday 2:00 PM

Day 8 Stock Transactions and
Dividends
Equity Analysis using
Regression and Time-Series
Modeling in Alteryx

Chapter 8 of the textbook;
E-lecture videos

Chapter 7 Homework due 2:00PM
Synchronous class meeting on Zoom 9:00 — 11:00
TCU Online Quiz- Available from Tuesday 6:00

PM - Wednesday 2:00 PM

Day 9 Statement of Cash Flows
Equity Analysis using
Regression and Time-Series
Modeling in Alteryx

Chapter 11 of the
textbook;
E-lecture videos

Chapter 8 Homework due 2:00PM
Synchronous class meeting on Zoom 9:00 — 11:00
TCU Online Quiz- Available from Wednesday

6:00 PM - Thursday 2:00 PM

Day 10 Review/Catch up
Final Exam Chapters 6, 7, 8, 11

Synchronous class meeting on Zoom 9:00 — 11:00
TCU Online Final Exam Friday 11:00 AM-

Sunday 11:59 PM

Equity Models and Summary Report due by
midnight
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